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I- BACKGROUND 

 

The Agreement on the Conservation of Cetaceans of the Black Sea, Mediterranean Sea and Contiguous 

Atlantic Area (ACCOBAMS), concluded under the auspices of the Convention of Migratory Species of 

Wild Animals (UNEP-CMS), has entered into force in 2001 and is now binding on 24 States (Albania, 

Algeria, Bulgaria, Croatia, Cyprus, Egypt, France, Georgia, Greece, Italy, Lebanon, Libya, Malta, , 

Monaco, Montenegro, Morocco, Portugal, Romania, Slovenia, Spain, Syria, Tunisia, Turkey, Ukraine).  

The general purpose of ACCOBAMS is to achieve and maintain a favorable conservation status for 

cetaceans, by improving current knowledge of these animal. To this end, Parties shall co-operate in 

order to develop common tools for the collection and dissemination of information about cetaceans 

and to organize training courses and education programmes. 

 

The 2017-2019 ACCOBAMS Work Programme (Resolution 6.5 adopted by Parties during MOP6 in 

November 2016), included the organization by the ACCOBAMS Permanent Secretariat of training on 

the use of photo-id and the promotion of the use of catalogues or web-based databases of photo-IDs. 

 

II- OBJECTIVE 

 

The 5 days training session for experts of the ACCOBAMS area, in particular from ACCOBAMS Partners, 

has been organized, thanks to a voluntary contribution from Italy. It was organized in collaboration 

with SPA/RAC, IUCN Med, MedPAN and Lebanese CNRS, from 1st to 5th October 2018 in Lebanon.  

It was aimed at reinforcing capacity on (i) the use of photo-id, (ii) the use of databases for experts 

relevant to ACCOBAMS which may seem complex for non-trained experts, and (iii) the creation of 

catalogues with relevant data for cetacean conservation.  

The main objective was to go towards standardization of the methods / tools used to share and 

valorize the data collected (i.e. through scientific publications) on cetaceans in order to optimize the 

efforts undertaken by all stakeholders involved in cetacean conservation and to improve the status of 

cetacean. 

 

Around 40 participants from Mediterranean and Black Sea participated to the training. Final list of 

participants appears in Annex 1 of the report. 

 

The final Agenda appears in Annex 2 of the report. 

 

Trainers explained the participants how to use GPS and Qgis softwares, though exercises (Annex 3 ) 

and with a support guide (Annex 4) in order to be more comfortable with: 

- GPS data extraction 

- GPS data processing 

- Building of a database 

- The use of Qgis, more particularly: 

• Switch from Excel to Qgis 

• Import the data under Qgis 
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• Transform Points to lines (Transects creations and Calculating the length of the transects) 

• General tools of Qgis 

• Create a layer (CCH) 

• Create an attribute table 

• Create polygones 

• Create a map 

 

 

 

  

  
 

 

 

 

III- CONCLUSION 

An evaluation form was filled by each trainee at the end of the training. All feedbacks are positive. It 

seems that the proposed format was very adapted to the needs from experts. 
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ANNEX 1 – LIST OF PARTICIPANTS 

 

ALI Malek 

Tishreen University 

Basic Sciences Department, Faculty of Agriculture, Tishreen University,  

Lattakia, SYRIA 

Tel: + 963933990370 

Email: malekfaresali@gmail.com 

 

AMENGUAL Pep  
Chief of Service of research of the Spanish National Park’s Network  
C/ Hernani 57 fifth floor,  
Madrid 28020 
SPAIN 
Email : PAmengual@oapn.es 

 

ATZORI Fabrizio 

Marine Protected Area “Capo Carbonara” 

Via roma 60 

09049 Villasimius 

ITALY – Sardinia 

Tel : +393483424917 

Email : direzione@ampcapocarbonara.it 

 

BENABDI Mouloud 

Association Ecologique Marine Barbarous  

Quai d’Alexandrie Port d’Oran Algérie 

31000 Oran 

ALGERIA 

Tel : +213 676820490 

Email : contact@barbarous.org  

 

BENMESSAOUD Rimel 

Institut National d’agronomie de Tunisie (INAT) 

App Ben Mahmoud, Bloc 25, Log 338, Cité Olympique 

2020 Tunis 

TUNISIA 

Tel : +216 98520051 

Email : Benmessaoud_rimel@yahoo.fr  

 

BOUHADJA Mohamed El Amine 

CNRDPA 

208 Rue 17 Septembre 1956- Ouled Yaich 

09100 Blida 

ALGERIA 

Tel : (+213)671 80 80 52 

Email : Bouhadja.amine@gmail.com  

mailto:malekfaresali@gmail.com
mailto:PAmengual@oapn.es
mailto:direzione@ampcapocarbonara.it
mailto:contact@barbarous.org
mailto:Benmessaoud_rimel@yahoo.fr
mailto:Bouhadja.amine@gmail.com
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CORRIAS Valentina 

Institute for Costal Marine Environment (IAMC-CNR) 

Detached Unit of Messina - Spianata S. Ranieri, 86 

98122 Messina 

ITALY 

Tel : +39 392.0218294 

Email : valentina.corrias@iamc.cnr.it  

 

DE LORENZI Tommaso 

DelTa association 

Località Giasbana 8  

34070 San Floriano del Collio 

ITALY 

Tel: +393336150121 

Email : tdelorenzi@gmail.com  

 

DIRYAQ Salih 

EGA Libya (Environment General Authority – Libya) 

00218 Sirte 

LIBYA 

Tel : +218 913709318 

Email : saldery@gmail.com  

 

ELMAKI Elagil 

Director of Nature Conservation Department (EGA) 

LIBYA 

Email: makeeagalee@yahoo.com 

 

FOUAD Mahmoud 

Environics, Environment and Development Advisors 

6 Dokki Street, Giza 

12311 Cairo 

EGYPT 

Tel: +201221177671 

Email : Mahmoud_ncs@yahoo.com  

 

GHALAB Ahmed 

Egyptian Environmental Affairs Agency -   Red Sea Protectorates  

Red Sea Protectorates office  - Hurghada –red sea governorate - Cairo – Egypt  

Hurghada  

EGYPT  

Tel : +201027601744 

Email : Ahmedghallab968@yahoo.com  

 

 

 

mailto:valentina.corrias@iamc.cnr.it
mailto:tdelorenzi@gmail.com
mailto:saldery@gmail.com
mailto:makeeagalee@yahoo.com
mailto:Mahmoud_ncs@yahoo.com
mailto:Ahmedghallab968@yahoo.com
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GIARDINA Fabio 

Marine Protected Area Pelagie Islands 

Via Cameroni 

92010 Lampedusa 

ITALY 

Tel: +393462104314 

Email : fabiogiardina2@gmail.com  

 

GIGOU Alexandra 

Chargée de mission espèces, habitats et écosystèmes marins 

Agence française pour la biodiversité 

Parc naturel marin du golfe du Lion 

2 impasse Charlemagne 

66 700 Argelès-sur-MEr 

FRANCE 

Tel: +33 4 68 68 55 90 / +33 6 74 52 01 91 

Email: alexandra.gigou@afbiodiversite.fr  

 

GOL'DIN Pavel  

Cand. Sci., Assoc. Prof., Leading Researcher 

Department of Evolutionary Morphology, 

Schmalhausen Institute of Zoology of NAS of Ukraine 

15 Bogdan Khmelnytskyi Street 

Kyiv - 30, UKRAINE 01030 

Tel.: +380 44 2343093 

Email: pavelgoldin412@gmail.com 

 

GURIELIDZE Zurab  

Ilia State University 

3/5 Cholokashvili Ave 

0162 Tbilisi 

GEORGIA 

Tel: +995 599 56 80 31  

Email: zurab_gurielidze@iliauni.edu.ge 

 

JOVICEVIC Mihailo  

University of Montenegro 

Sv.Petra Cetinjskog 73 

81000 Podgorica 

MONTENEGRO 

Tel: +382 69 138181 

Email : mihajov@gmail.com 

 

KOPALIANI Natia  

Ilia State University 

3/5 Cholokashvili Ave 

0162 Tbilisi 

mailto:fabiogiardina2@gmail.com
mailto:alexandra.gigou@afbiodiversite.fr
mailto:pavelgoldin412@gmail.com
mailto:zurab_gurielidze@iliauni.edu.ge
http://gmail.com/
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GEORGIA 

Tel: +995 599 55 29 94  

Email: natia_kopaliani@iliauni.edu.ge 

 

LOUDRHIRI Abdelali 

Département de la Pêche Maritime 

BP 476, Haut Agdal, Rabat 

10080 Rabat 

MOROCCO 

Tel : +212 537688277 

Email : loudrhiri@mpm.gov.ma  

 

 

MAZOVSKA Svitlana 

Member of the Scientific Advisory Council on Marine Mammal Protection under the Ministry of Ecology 

and Natural Resources of Ukraine 

Odessa, Ukraine 

Tel. +38(095)94-09-833, +38(098)887-57-67 

Email : lana.mazovskaya@ukr.net  

 

MICHAELIDES Savvas 

Department of Fisheries & Marine Research 

101 Vithleem Str - 2033 Nicosia 

CYPRUS 

Tel : +357.22807851 

Email : smichaelides@dfmr.moa.gov.cy  

 

PAIU Romulus-Marian 

Mare Nostrum NGO 

Alexandru Lapusneanu Blvd., No 75, Bl. LV4, Sc. A, Ap. 19. 

900613 Constanta 

Romania 

Tel: +40720258785 

Email: marian_paiu@marenostrum.ro  

 

PETROS Stavrou 

Department of Fisheries & Marine Research 

101 Vithleem Str - 2033 Nicosia 

CYPRUS 

Tel : +357.22807855 

Email : pstavrou@dfmr.moa.gov.cy 

 

POPOV Dimitar 

Green Balkans NGO 

1 Skopie str., office 10 

4013 Plovdiv 

BULGARIA 

mailto:natia_kopaliani@iliauni.edu.ge
mailto:loudrhiri@mpm.gov.ma
mailto:lana.mazovskaya@ukr.net
mailto:smichaelides@dfmr.moa.gov.cy
mailto:marian_paiu@marenostrum.ro
mailto:pstavrou@dfmr.moa.gov.cy
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Tel: +359885108712 

Email: dpopov@greenbalkans.org  

 

POPOVIĆ Jelena  

University of Montenegro 

Hercegovačka 97 

81000 Podgorica 

MONTENEGRO 

Tel : +382 68 048 388 

Email : popovic.jelena4@gmail.com  

 

REDONDO RODRÍGUEZ Marisol  

Técnico de Conservación 

Centro Montes y Aserradero de Valsain 

C/ Primera, 11-  40109 Valsaín SEGOVIA 

Tel : +963 921470037  

Email : sredondo@oapn.es 

 

SAIED Almokhtar  

Head of Marine and wildlife section  

Nature Conservation Dept  

Environment General Authority  

P.O.Box 13793 Tripoli/LIBYA  

Tel: 00218 91 455 96 15 

Email: mok405@yahoo.com  

 

SELMANI Rabah  

CNRDPA 

11 bvd colonel Amirouche 

420037 BouIsmail 

ALGERIA 

Tel :  

Email : rabah_selmani@hotmail.fr 

 

TAI Imane 

Institut National de Recherche Halieutique 

2, BV Sidi Abderrahmane  

20180 Casablanca 

MOROCCO 

Tel : +212 672827416 

Email : taiimane.it@gmail.com  

 

TONAY Arda M. 

Istanbul University, Faculty of Aquatic Sciences 

Ordu Cad. No:8 Laleli Fatih 

34480 Istanbul 

TURKEY 

mailto:dpopov@greenbalkans.org
mailto:popovic.jelena4@gmail.com
mailto:JDones@oapn.es
mailto:mok405@yahoo.com
mailto:rabah_selmani@hotmail.fr
mailto:taiimane.it@gmail.com
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Tel : +905359402222 

Email : atonay@istanbul.edu.tr  

 

ZELEZNIK Jure  

Ulica Simona Jenka 13c, Domzale 

SLOVENIA 

Tel: +386 68 663 667 

Email: zeleznik.jure14@gmail.com 

 

mailto:atonay@istanbul.edu.tr
mailto:zeleznik.jure14@gmail.com
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LEBANESE EXPERTS 

 

ABBOUD ABI-SAAB Marie  

 

ASSAF Laury  

 

AWAD Viviane  

 

FAKHRY Milad  

 

GHANEM Abir  

 

GHSOUB Myriam  

 

HASSOUN Abed El Rahman  

 

JABER Houssein  

 

JEMAA Sharif  

 

KHALAF Gaby  

 

LAHOUD Imad  

 

LTEIF Myriam  

 

MAHFOUZ Celine  

 

MINA Roula  

 

MOUAWAD Rita  

 

OUBA Anthony  

 

SAMAHA Ziad  

 

TAREK Elie  

 

 

 

TRAINERS AND ACCOBAMS PERMANENT SECRETARIAT 

 

 

DAVID Léa 

Task Manager « Aires Protégées pour les cétacés » du Comité Scientifique de l’ACCOBAMS 
EcoOcéan Institut  
18 Rue des Hospices 
34090 Montpellier, France  
Tel :+33 4 67 84 28 87 
E-mail : lea.david2@wanadoo.fr 
 

GAUFFIER Pauline 

Urbanización La Almadraba puerta 140 
Calle Río Segura, 89 
30385 Playa Honda, Cartagena 
Murcia - Spain 
Tel :+34 658 199 045 
E-mail : paulinegauffier@hotmail.fr 

 

Dhia GUEZGUEZ 

Data Management & Computing Officer 

Specially Protected Areas Regional Activity Centre (SPA/RAC) 

Boulevard du Leader Yasser Arafat - B.P. 337  

1080 Tunis Cedex - Tunisia 

Tel: +216 71 206 485 / +216 97 392 011  

E-mail : dhia.guezguez@spa-rac.org  

 

mailto:lea.david2@wanadoo.fr
mailto:dhia.guezguez@spa-rac.org
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MONTIGLIO Camille 

ACCOBAMS Permanent Secretariat 
Communication Officer 
Les Terrasses de Fontvieille 
Jardin de l’UNESCO 
MC-98000 MONACO 
Tel: +377 98 98 20 78  
E-mail : cmontiglio@accobams.net 

 

MOULINS Aurélie 

CIMA Research Foundation 
Campus Savona, Via Magliotto 2 
17100 Savona - ITALY 
E-mail : aurelie.moulins@cimafoundation.org  

 

PANIGADA Simone 

Chair of the ACCOBAMS Scientific Committee 
Tethys Research Institute 
Viale G.B. Gadio 2 
20 121 Milan – ITALY 
Tel: (+39) 02 7200 1947 – (+39) 02 6694 114 
E-mail : panigada69@gmail.com 
 

ROUL Marine 

EcoOcéan Institut  
18 Rue des Hospices 
34090 Montpellier, FRANCE  
Tel :+33 4 67 84 28 87 
E-mail : roul.marine@gmail.com  

 

SALIVAS Maylis 

ACCOBAMS Permanent Secretariat 
Programme Officer 
Les Terrasses de Fontvieille 
Jardin de l’UNESCO 
MC-98000 MONACO 
Tel: +377 98 98 42 75  
E-mail : msalivas@accobams.net 
 
 

 

mailto:cmontiglio@accobams.net
mailto:aurelie.moulins@cimafoundation.org
mailto:panigada69@gmail.com
mailto:roul.marine@gmail.com
mailto:msalivas@accobams.net
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ANNEX 2 - PROGRAMME 

 

Monday 1 October 2018  

Official welcome statements and introduction to the training 
CNRS 

ACCOBAMS 

1/ NETCCOBAMS – Strengthen collaboration between all ACCOBAMS experts 
Maylis SALIVAS  

Léa DAVID 

2/ Reporting quality assured data related to the EcAp common indicators on 

marine mammals: The SPA/RAC Mediterranean Platform on Biodiversity 
SPA/RAC representative 

3/ National and regional databases on strandings Maylis SALIVAS 

4/ CCH and IMMAs: for a better consideration of cetaceans in MPAs - examples of 

practices implemented and needs - 

Simone PANIGADA, 

Alexandra GIGOU 

Fabrizio ATZORI 

Pep AMENGUAL 

 

Tuesday 2 October 2018  

5/ Photo-Id – from raw data to a photo-ID catalog  

5.1 Introduction to photo identification techniques Léa DAVID 

5.2 Example of data catalogue and matrix on Bottlenose Dolphin Marine ROUL 

5.3 Example of data catalogue and matrix on Risso’s dolphin Aurélie MOULINS 

5.4 Example of data catalogue and matrix on fin whale Simone PANIGADA 

5.5 Practical exercise from raw data (data provided by participants or 

provided by trainers) 

Marine ROUL  

Pauline GAUFFIER 

Aurélie MOULINS 

 

Wednesday 3 October 2018  

6/ A tool needed for data recovery: GIS – from raw GPS data to maps of effort and 

observations (sea trip and data processing) 

 

Group 1 : Sea trip (morning) 

Introduction to GIS techniques (afternoon) 

Pauline GAUFFIER 

Léa DAVID 

Group 2 : Introduction to GIS techniques (morning) 

Practical exercise with data provided by trainers (afternoon) 

Aurélie MOULINS  

Marine ROUL 

 

Thursday 4 October 2018  

6/ A tool needed for data recovery: GIS – from raw GPS data to maps of effort and 

observations (sea trip and data processing) 

 

Group 1 : Practical exercise with data provided by trainers (morning) 

Practical exercise with data from the sea trip (afternoon) 

Pauline GAUFFIER 

Léa DAVID 

Group 2 : Sea trip (morning) 

Practical exercise with data from the sea trip (afternoon) 

Aurélie MOULINS  

Marine ROUL 
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Friday 5 October 2018  

7/ Valorization of available data in the ACCOBAMS area - transfer of expertise and 

of know-how from experts to other experts 

Aurélie MOULINS  

Marine ROUL 

Pauline GAUFFIER 

Léa DAVID 

8/ Closure of the training 

Milad FAKHRI 

Gaby KHALAF 

Maÿlis SALIVAS 
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ANNEX 3 – QGIS Exercise 
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Element of the exercise 

Data 
➢ Files (.txt) with GPS tracks 

➢ Road sheets (.pdf) with the indications of the exits 

➢ Shapefile (.shp) and raster (.tif) file for mapping (we are not responsible for the boundaries 

and territorial boundaries of the files) 

Software 
➢ Notepad to open .txt files 

➢ Calculation software: Excel, free office, Open Office ... to create the database 

➢ Qgis for SIG 

Instructions 

GPS data processing 
Create a database from the GPS file, see the corresponding part in the guide. 
 
To complete the database 
In this exercise are considered out of effort periods where : 

➢ There is no effort of observation 

➢ There is interruption of the transect because of cetaceans 

➢ Weather conditions are poor: Wind and Sea above Beaufort 4, Visibility = fog (brouillard in 

french). 

➢ Transect conditions are not respected: speed below 7 km / h 

THT column code: 
➢ In effort: T 

➢ In cetacean sighting: OBS 

➢ No effort: HT 

➢ Bad weather conditions: HTM 

➢ Bad speed: HTV 

ID transect, the transect identifier will be composed of the name of the mission, the year 
and the transect number: GEDGeM_2014_001, GEDGeM_2014_002…. 
It is possible to automate the numbering of transects if the columns "date" and "THT" are 
well filled as well as the column "ID" (See the formulas in the Excel file). 
 

Starting Qgis 
After having installed QGis beforehand, it is necessary to install additional modules that will 
allow certain operations to be carried out. (See the guide). 
Open the shapefile and raster layers under Qgis (See the guide). 
 

Using Qgis  
Import the database under Qgis and transform it into a shapefile. 
Create transects from GPS points and calculate their length. 
Creation of a shapefile for CCH (creation of a shape layer, creation of an attribute table, 
creation of polygon corresponding to the CCH) for your geographical area). 
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ANNEX 4 – Guide for data analysis 

 

 
 



 
1 GPS data extraction ...................................................................................................................... 19 

2 GPS data processing ...................................................................................................................... 20 
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2.2 Date and Time ................................................................................................................................. 23 

2.3 Leg Speed and Leg Course ............................................................................................................... 23 
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4.2 Installing modules / expansion ........................................................................................................ 25 
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5 Switch from Excel to Qgis .............................................................................................................. 27 

5.1 Import the data under Qgis ............................................................................................................. 27 

5.2 Points to lines .................................................................................................................................. 29 
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5.2.2 Calculating the length of the transects.................................................................................... 30 

6 General tools of Qgis .................................................................................................................... 33 

6.1 Select and deselect entities ............................................................................................................. 33 

6.2 Measure with the rule tool .............................................................................................................. 33 

7 Create a layer (CCH) ...................................................................................................................... 34 

8 Create an attribute table ............................................................................................................... 35 

9 Create polygones .......................................................................................................................... 36 

9.1 Define the option of snapping ......................................................................................................... 36 

9.2 Add entities...................................................................................................................................... 36 

9.3 Modify a node/vertex : node tool ................................................................................................... 39 

9.4 List of the tools of the editing mode ............................................................................................... 39 

10 Create a map ............................................................................................................................ 40 
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GPS data extraction 
Software : MapSource 

Manual : 

➢ Start MapSource 

➢ Connect the GPS to the computer via the USB cable. 

➢ Start GPS 

➢ In order to transfer the GPS data to the computer, the GPS must pick up a signal otherwise the 

computer does not detect it 

➢ Click on the "Receive device" icon: if the GPS is detected, the software finds it automatically..  

➢  Selected Waypoints and Tracks for downloaded 

GPS tracks then click on “Receive” 

 

The tracks appear 

 

To record tracks : 

➢ « Fichier » 

➢ « Enregistrer sous » 

➢ Format of the record is ".gdb" which is the format of MapSource (to open later traces in the 

software) or ".txt" for data processing. 
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GPS data processing 
Software : Notepad and Excel 

 Open the file containing the GPS track (.txt)  

Select all (ctrl+A) and to copy (ctrl+C) 

Open Excel and then paste (ctrl+V) 

 

Delete empty lines and unnecessary lines: only the line containing the column headers and the lines of the 

GPS points. Warning unnecessary lines are automatically created at the beginning of tracks. 
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The file must be like this: 

 

Column headings : 

➢ Header: corresponds to the GPS recording mode 

➢ Position: GPS coordinates 

➢ Time: date and time 

➢ Altitude: theoretical not always very reliable .... 

➢ Depth and Temperature: always empty unless a probe is connected 

➢ Leg Length: length between the GPS point and the previous GPS point in meter 

➢ Leg Time: time between 2 points 

➢ Leg Speed: the speed between 2 points in kilometers per hour (kph) 

➢ Leg Course: the cap between 2 points 

In this state the data cannot be used in a database, it is necessary to: 

➢ Format the position and convert it to decimal degrees to be recognized by QGis, 

➢ Separate the date and time 

➢ Remove the text from the "Leg" columns 

Geographical position 

Separation of latitude and longitude: 

➢ Insert 4 new columns after column "B" 

➢ Select column "B" 

➢ In the "Data" tab, click on the "Convert" icon 

➢ Select the "Fixed width" option then click on next 

➢ We must now position the separators so as to have 

4 columns: 

o In the 1st, there will be the N 

o In the 2nd, the latitude 

o In the 3rd, the E 

o And in the 4th the longitude 

➢ Then click on Finish 
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 The result is the following: 

 

We must now delete the "spaces" present in the coordinates: 

➢ Select columns "C" and "D" 

➢ In the "Home" tab, click on the "Search and select" icon 

➢ Click on "Replace": in “Search” put in "space" and don’t put anything in “Replace by” 

➢ Click on "Replace all", result obtained: 

 

 

Conversion to decimal degrees: 
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➢ Insert two columns one after C and the other after E 

➢ Open latitude and longitude conversion Excel file 

➢ Copy / Paste latitudes in the conversion file and stretch the formula to calculate all the points. 

➢ Select the values in the decimal degrees column and copy 

➢ Paste into the working file, 2 things: 

o Be careful not to shift positions 

o Make a special "Value" collage otherwise Excel will paste the formula. 

➢ Do the same for the longitude 

Result: 

 

Date and Time 

Separation of date and time: 

➢ Insert one column after H 

➢ Select column "H" 

➢ In the "Data" tab, click on the "Convert" icon 

➢ Select the "Delimiter" option then click on next 

➢ For separator, tick space and then click on finish  

 

Leg Speed and Leg Course 

Delete text characters to keep only the numbers: 

➢ Select the columns 

➢ In the "Home" tab, click on Search and replace, then replace 

➢ For speed put "kph" in search and nothing in replace and click on replace all 

➢ For cap put "true" in search and nothing in replace and click on replace all 

The information is now transferable into the database. 
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Database 
The organization depends on its use, some element remains nevertheless obligatory and certain more 

practical to be found. 

Metadata: 

➢ Mission: name of the mission 

➢ Organization: Forwarder / Executor of the Mission 

➢ Author: Referents on the mission 

➢ Name of the boat 

GPS data: 

➢ Speed 

➢ Cap 

➢ Latitude 

➢ Longitude 

➢ Date 

➢ Time 

Transect data: 

➢ Transect ID: final transect code for GIS 

➢ Transect number: transect number 

➢ THT: To indicate if on the point we are in transect effort 

➢ Comment: to specify elements 

Meteorological data : 

➢ Wind force 

➢ Wind direction 

➢ Force of the sea 

➢ Sky 

➢ Visibility 

Other columns can be added according to the information collected during the mission. 

Note: Qgis doesn’t read characters with accents, so do a search and replace them with the same letter 

without accents and don’t put semicolon in the base. 

➢ Save the database in .cvs format (separator: semicolon). 

➢ Start Qgis, open a new project 

➢ To treat the file under Qgis, open the .csv file, with the command "Add a delimited text 

layer". 
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Starting Qgis 

Creating a project 

Start Qgis 

Start a new project by clicking on the icon « New » 

To save the project (which will contain all the layers of the exercise) click on the "File" menu, "save as", give 

it a name and click on save. 

 

Installing modules / expansion 

To do this click on the "Extension" menu and install / Manage extensions 

Then you have to type the name (if you know it) or a keyword to find the extension and click on install. 

Here is a non exhaustive list of extension and their function: 

• Point2One : Transform points online or polygon (NECESSARY FOR EXERCISE) 

• Statist : Calculate and display statistics for a field 

• GroupStat : Statistics and analysis for vector layer data 

• Vérificateur de topologie : Lets you find the topology errors present in a vector layer 

• Outils GPS : Tools to load and import GPS data (only works with certain GPS) 

• OpenLayers Plugin : Allows you to display Googlemap, Bing Maps, OpenStreetMap background 

maps ... 

• Layers Combinaisons : Allows you to save an image of the layers, it is especially used if several 

cards must be layout at the same time. 

• Digitizing Tools : different tools useful during digitizing sessions 

 

 Open a shapefile 

To open a shapefile (.shp, .tab) click on the button  
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This window opens, leave default check file and system encoding. Click on Browse 

 

By default Qgis recognizes files in .shp, selected the 

layer (s) you want to open and click on open (2x). 

 

 

 

 

 

 Change 

the style 

/ rendering of the layer : 

Once the layers are loaded, they appear in the "layers" insert 

to modify the rendering of a layer right click on the layer and 

then on property then in the style tab. 

Styles are already pre-download in qgis for the countries layer 

select the style "land" and click on "OK" 

 

 



ACCOBAMS-MOP7/2019/Inf10 

27 

 Open a raster file 

To open a raster file (.tif) click on the button  

This window opens, select the file in .tif then click on open. 

In message appears which precises that by default the SCR 

of the layer was defined by the WGS84. This means that 

Qgis did not find geo-referencing related to the tif file. 

You have to check that the image is in the right place. 

Switch from Excel to Qgis 

Import the data under Qgis 

➢ For open file .csv, click on the button 

o File format: choose "custom delimiters" and "semicolon". 

o Records: Nbrs of lines to ignore 0 and check headers in 1st line. 

o Field options: everything must be unchecked 

o Definition of geometry: tick point, field X put the longitude and Y fields the latitude 

o Click OK 

 

➢ Select the reference coordinate system: WGS84 / EPSG: 4326 and click OK 
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➢  Save the layer in shp format (this allows you to make changes to the layer directly from Qgis): 

o Right click on the layer and save as 

o Give it a new name 

o For the SCR choose a reference in metric for 

example: 

▪ In France (RGF93, EPSG: 2154) 

▪ In Europ (ETRS89 / EPSG :3035) 

▪ In Lebanon (UTM36 / EPSG :32636) 

o  Check the box: Add files to map and click OK 
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Points to lines  

Transects creations 

To connect the points and visualize the transects, use the extension « Points2One ».  

➢  Click on the icon « P² » 

➢ Select shp layer with GPS point 

➢ Choose "create lines" 

➢ Group features by "THT" / "ID-transect" 

➢ Choose a name and location for the output 

.shp, for example 

20171011_transect_ligne_PNMGL 

➢ Check "Add results to canvas » 

 

 

 

 

Once formatted, the resulting layer appears as 

follows: 
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Calculating the length of the transects 

To calculate the length of transects, you must either: 

➢ The layer has a projected SCR (that is to say that the units are not degrees but meters / miles / 

feet…,  example: for the meters in Lambert 93) 

➢ The project is configured in units projected (But it will give approximate results to use when last 

resorts) for that go into the "Project" menu then click on the property of the project. In the general 

tab, section "measurements" check that the units of measurement are not degrees. Then click on 

« ok » 

For the exercie choose the meters 

 

➢ Select the transects layer 

➢ Switch to edit mode by clicking on the pencil icon 

➢ Then right-click on the layer, to open the attribute table. 
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➢ Open the field calculator (calculatrice de champ). 

 

➢ In the field calculator : 

o "Create a new field" and name it, for example "Distance_km"; 

o Choose "decimal number"; to have digits after the decimal place 1, 2 or 3 in the 

corresponding boxe 

 

o In "geometry", choose "$length" by double-clicking → the formula appears in the window 

on the left. 

o Divide by 1000 to get kilometers. 
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➢ The "Distance" column with values per transect appears in the attribute table. 
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General tools of Qgis 

Select and deselect entities 

The QGIS toolbar provides several feature selection tools. Select the layer in which you want to select an 

element. 

To select one or more entities, click  and choose your tool. 

To deselect all entities, click  

Measure with the rule tool 

Click on the icon  and select the tool you want to use. 

The tool allows you to place points on the map. The length of each segment is displayed in the measurement 

window as well as the total cumulative length. 

To stop the measurements, right click. Note that you can interactively change the units of measures in the 

Measures dialog box. They replace the Preferred Action Units of the options. 
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Create a layer (CCH) 
in order to create a new layer, please click on the following button:  

➢ Select « New Shapefile Layer » 

➢ For type, select: Polygon 

➢ Keep all the other settings / and « Ok ». 

 

Then, give a name to the layer (CHH_nameofcountry), BE CARREFUL: note where you register it!!!!!! 
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Create an attribute table 
In order to modify the attribute table, you shall be in « toggle editing » (click on the following 

button) 

Open the attribute table of the CCH layer 

To create a new field, click on the button « New Field »   

The name of the first field of the attribute table is « Threat », 

The type is text 

The length is 80 characters  

You will create 8 fields with the following characteristics: 

 

Name Type Length Description 

Threat Text 80 Direct threat: By-catch, Ship strike, Harassment, 
Impulsive noise, Depredation, etc. 

Species Text 80 Initial of the relevant species (Tt, Sc, Bp, Pm,…) 

Area Text 80 Name of the relevant area 

Intensity Text 80 Intensity of the threat: Important, medium, low, 
potential 

Season Text 80 Period of the year 

Ref Text 80 Relevant expert for the CCH 

Country Text 80 Country 

Comments Text 200 Details on the threat, for example for bycatch you an 
precise the relevant fishing gears  
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Create polygones 

1.1 Define the option of snapping 

Before being able to edit the node/vertex it is important to select the snapping option (tolerance and 

searching distance) at values that will ensure editing polygon in an optimal way.  

Snapping distance tolerance : is the distance used by QGIS to look for node/vertex that are the nearest of 

the location of the node/vertex you just create or you are moving, so they can be connected.   

IT IS HELPFUL TO OVERLAPP NODE/VERTEX AT EXACTLY THE SAME LOCATION  

To do that : menu « Settings » → « snapping option » 

In “layer selection » select « Avanced » 

➢ In the first column, select the layer CCH and Countries 

➢ Concerning the Mode, keep the default option « to vertex and segment »  

➢ For column Tolerance, put 10 

➢ For unit, put « pixels » for both layers 

➢ To avoid intersections, tick the box of the layer Countries (so your node will not be linked to the 

land and you will avoid creating a CCH on land) 

 

 

Add entities 

Remember : to create a polygon within the layer CCH, this layer should be in editing mode. 
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Clic on the icon « add a polygon »  

You will see a cross on the map, it is your « mouse ». Clic left to 

begin to place the first node/vertex of your polygon, and 

continue to draw the entire polygon. 
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If your CCH is near the coast, you may not draw this side precisely as with the option 

« avoid intersection » the polygon will be cut by the layer of Countries and you will got a 

clean frontier.   

To finalise the polygon, click right 

(wherever you want).  

This window appears : fill the columns with the 

informations needed for each CCH 

and click on OK.  

One polygon means one species and 

one threat 

If you have got several species or threats over the same area (polygon), you can duplicate this shape, as : 

➢ Select the polygon  

➢ Open the attribute table   

➢ Click on the icons  copy/paste  

After that you just need to modify the information in the table so that in your “pasted” polygon you get the 

new information on the species, threats, etc. 

 

In order to save the modifications of the CCH layer, click on the “save” icon. 
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Modify a node/vertex : node tool 

If you want to change the polygon shape, you can modify it (your layer should be in editing 

mode) using the node tool.  

Click on the « node tool » icon, and select your entity (polygon) you want to 

modify. Small red box will appear at each node/vertex, indicating that it is well 

selected.  

➢ Selecting vertices: You can select vertices by clicking on them one at a 

time, by clicking on an edge to select the vertices at both ends, or by 

clicking and dragging a rectangle around some vertices. When a vertex is selected, its color changes 

to blue. To add more vertices to the current selection, hold down the Ctrl key while clicking. Hold 

down Ctrl when clicking to toggle the selection state of vertices (vertices that are currently 

unselected will be selected as usual, but also vertices that are already selected will become 

unselected). 

➢ Adding vertices: To add a vertex, simply double click near an edge and a new vertex will appear on 

the edge near to the cursor. Note that the vertex will appear on the edge, not at the cursor 

position; therefore, it should be moved if necessary. 

➢ Deleting vertices: Select the vertices and click the Delete key. Deleting all the vertices of a feature 

generates, if compatible with the datasource, a geometryless feature. Note that this doesn’t delete 

the complete feature, just the geometry part; To delete a complete feature use the  Delete 

Selected tool. 

➢ Moving vertices: Select all the vertices you want to move, click on a selected vertex or edge and 

drag in the direction you wish to move. All the selected vertices will move together. If snapping is 

enabled, the whole selection can jump to the nearest vertex or line. 

List of the tools of the editing mode 

The main tools are : 

 

 

The tools for advanced numerisation are the following : 
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Create a map 
To create a map with Qgis, please open « New Print Composer » : you can click on the 

following button, or click on the menu « Project »  

A window opens: give the name of your map and click on “OK” 

➔ this window will appear: 

 

 

 

 

Explications of all functionalities: 
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Elements of a map: 

➢ The map is created with the button “add new map”  

➢ A title is created with the button “add new label”  

➢ A north arrow is created with the button “add image” 

➢ A legend is created with the button “add new legend”  
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➢ A scale is created with the button “add new scalebar”  

 

 


